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 Interface Metaphors used by Irfanview32  
 
 
What is Irfanview32 and how did I come to use it? 
 
Irfanview32 is a graphics viewer with some image manipulation and conversion 
features. It is offered as freeware for non-commercial use by Irfan Skiljan of Austsria. 
For the purposes of this discussion, I am inspecting version 2.83, available in 1996-
1997.  
 
This version was installed on my Windows95 computer in 1997. A friend sold us his 
older digital camera, installed this software, and taught my husband to use it to view and 
save his photo images. The primary goal was to sell auto parts on eBay using photos of 
the items. 
 
I have used this off and on for a few years, but have never explored what it might do 
beyond moving pictures from an older digital camera via serial port to the desktop and 
then saving the file.  
 
 
Who uses it? 
I have seen this product used by several people who have digital cameras, and 
assumed that was the primary purpose. Some of these people have compact flash 
cards and others use 3 ½” floppies. Irfanview is able to show you all the pictures in a 
directory or on a floppy as a slide show.  
 
Most people who use this software are beginner to intermediate users, but they need 
some initial instruction on how to use it. Those who are more technically adept and use 
photo manipulation in their everyday work will most likely have more sophisticated 
software to do it with.  
 
You need only a few specific commands to accomplish the transfer and saving of a 
photo. There is no on-line help included with the application. 
 
 
How do they use it and for what purposes? 
 
My husband was the one who initiated its use and learned the step-by-step procedures 
for moving photos onto the hard drive. He uses it regularly for the photos he posts of car 
parts on eBay.  
 
My first real acquaintance came when the computer crashed and I had to reinstall it and 
configure it for him. This required a phone call to the fellow who did the original install. 
The problems I encountered were due to the camera software rather than the Irfanview, 
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and he was able to steer me in the right direction. Since then I have used it for family 
photos to send by email. 
 
My brother-in-law uses it for viewing photos he takes with his digital camera and uses in 
the course of his work as a field agent in the Forest Service. He also uses it for family 
pictures. 
 
The steps used to move the photo from the camera to the desktop and save it to the 
hard drive are: 

• Start the process 
• Interact with the camera interface software 
• Save the photo 

 
You start the process, after opening the application, using 
Alt-F (file menu), A (acquire). If you have more than one 
source, you may need to select the source before the 
acquire command. 
 
Then, the camera software takes over the process of 
connecting, allows you to select which photo you want and 
acquires it. At the end of this process, the photo is 
displayed in Irfanview on the desktop. 
 
The next thing to do is save Alt-F (file menu), S (save). I 
have tried both the “save” and “save as” commands and 
they do the same thing for a newly acquired photo. You 
would expect that the save hot key would be Alt-S or S 
instead of V and save as would be Alt-A instead of S. 
 
 
What is the Metaphor? 
 
This software combines three metaphors, Scanner, Windows, and Graphics/Photo 
Manipulation. 
 
This is the opening screen.  

The command “acquire” suggests the activity of scanning. The “select source” 
command allows you to have both a camera and a scanner connected to the same 
computer. I first encountered the notion of acquiring an image when using a scanner, 
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and I have seen it used in conjunction with other software that integrates scanning 
interfaces such as Corel Photo-Paint and Canon printer/scanner. Irfanview doesn’t 
actually perform the scan, but it uses the metaphor I encountered with scanner 
software. It calls the camera’s device driver, collects the data from the camera’s flash 
card after you select it in the camera interface, and displays the photo onscreen. 
 
The application incorporates standards used 
in windows applications such as the toolbar, 
drop down menus and sub menus. Some of 
the terms are non-standard and may reflect 
the Austrian origin. The “File” drop down 
menu uses the term MRUD, and it took 
awhile to find the description - most recently 
used directories. 
 
Graphics, photography, and photo 
manipulation programs such as Corel 
Photo-Paint and Photoshop use the same 
terms found on the Image drop-down menu.  
Someone who has used such programs 
have no trouble guessing what Irfanview will 
do when the effect is selected. Even if you 
don’t have experience with these 
applications, you can guess that negative 
will turn the image to inverse colors in the 
same way as film negatives. The convert to greyscale and brightness are equally 
descriptive. The rotation and flip are easily understood. As a newcomer to this 
metaphor, you might not recognize or guess what gamma correction or the color depth 
commands do. 
 
This application can convert any image file into any other major format. 
 
 
Was the metaphor a wise choice? 
 
The windows metaphor was a good selection and builds on experience any windows 
user has already encountered. The graphics metaphor was a good selection because 
the terms used are accepted terminology. The scanner metaphor could be replaced with 
a file transfer or upload metaphor. I think of the activity as an import, copy, or 
conversion function between devices. The camera driver and software do the actual 
viewing and selection. While using this program, the transfer of the photo to the desktop 
is controlled by Irfanview so that the photo ends up in the controlled environment. 
 
 
Examples of appropriate use of metaphor 
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The windows style menu and tool bar follow accepted windows schema. The open, 
save, cut, copy, and paste buttons perform the actions you would expect. The left and 
right arrows move to the previous or next picture in the folder. There are tool tips and 
hot keys. The tool tips even worked on grayed out icons. 
 
The application uses a standard windows frame, so clicking in the upper left corner 
gives you the expected options of close, minimize and maximize. The appropriate 
symbols for those same operations are in the upper right. There is a blue title bar. 
Standard hot key combinations such as Alt-F4 work. There is grouping of icons on the 
toolbar such as cut, copy, and paste. The File and Edit menus are located to the left and 
the About menu is located to the right on the menu. 
 
There are triangles on the drop down menus indicating submenus. Hot keys are shown 
on the menus.  
 
The image effects are shown immediately. Image effects with sliding controls show a 
preview before selecting okay. 
 
The action paths are quick, with little redundancy and no need for it. 
 
All the commands needed for a task are located on the same menu. 
 
 
What are poor uses of metaphor and implementation? 
 
I was unable to determine what the up and down arrows could do for me. Tool-tips say 
they are previous page and next page.  
 
There are some icons that don’t work as you expect include the two at the far right. 

  
 
The big red P led me to believe it meant properties, and it does. But it means properties 
of the program, not the photo. For properties of the image or photo, you select the  
icon that gives information about the image. This may be reflective of the international 
origin.  
 
The tropical island icon looks like an image properties icon, but is really another path to 
the same About Irfanview message as when you click on About Irfanview from the 
“About” menu. This is redundant and isn’t important to completing an important activity. 
The information has nothing to do with a tropical island or photo. 
 
It’s unclear how you actually achieve the photo manipulation. There is no help available. 
You might think that by dragging a window into the workspace, the effects would occur 
there. The only thing you can do with that window is crop. I tried copying and pasting, 
but paste just replaces whatever photo was on the workspace. 
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It’s also unclear when the undo will work. I flipped a photo vertically, and was unable to 
undo. 
 
There are some odd commands on the file menu such as reopen, and MRUD.  I learned 
that the reopen means revert to original file and MRUD means most recently used 
directories. 
 
You can’t open more than one image. If you open or acquire a new image without 
saving the first one, you have lost it and you aren’t given any notification or asked to 
confirm. 
 
I tried the slideshow, and it works great. For a long time I couldn’t figure out how to exit 
without Alt-F4. Then I accidentally hit Ctrl instead of Alt, and the full screen exited. Then 
I tried Escape and that worked too. So, even though poorly documented, the program 
sticks to some expected standards. 
 
The resample and resize seem to accomplish the same things except one says 
“smoothing”. 
 
 
Concrete suggestions for improving the interface 
You can’t open more than one image. If you open or acquire a new image without 
saving the first one, you have lost it with no notification. There should be a notification if 
you are overwriting the workspace or will lose the effects you have just applied. 
 
This version of the program seems to be in transition between an early windows type 
application and a fully functional windows application. I haven’t looked at a more current 
version, but would hope that it has become a true windows application. 
 
During the slide show, the path is displayed at the top of the screen. There should also 
be text such as Escape to exit or a frame or hidden dropdown menus like you find in 
PowerPoint. 
 
There are some interesting options on the properties menu. You will notice the  
question mark icon and I tried to use it. The only place it seemed to work was the okay 
and cancel buttons.  The help should be expanded to work where you need it. 
 
The undo option should be the default. 
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Is it easy to learn? Not really. With some basic initial instruction, the program is easy to 
use. Through trial and error, you can see what the image commands and other options 
do because the changes take place immediately.  
 
I tried the option to set as wallpaper, and the image I was viewing became my 
wallpaper. Fortunately, the “previous wallpaper” command reverted back to what I really 
wanted for wallpaper.  
 
I wasn’t able to use the video and animation commands and it would help if there was 
an explanation of some sort. 
 
Are there safeguards built in? The simple answer it no. The undo command isn’t 
available to use unless you know to set it in the properties. The “reopen” command can 
be used to go back to the original version, but that isn’t intuitive. 
 
Is it based on tasks to be performed? Sort of. All the commands needed to import a 
photo and save it to a folder are on the File menu. All the image effects are located on 
the same menu. 
 
Is there user feedback and closure on tasks? User feedback is immediate. I can’t 
remember ever encountering an error message. When I clicked delete file, even though 
no file was being viewed, I was asked if I wanted to delete “filename”. It was the next to 
the last one in the directory. If I had a file open at the time, it asked if I wanted to delete 
the current file. But when I clicked okay, the image stayed on the viewer but was 
deleted from the directory. 
 
The copy file command and move file command  from the File menu were very 
confusing. I think this program was written for a very specialized process and then 
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offered to the general public. I don’t know why you would want to either move or copy a 
file to 5 different directories. I can’t figure out what active means, especially when I click 
the directory number and the window closes. I don’t like to experiment with processes 
that could be potentially damaging. When I copied the file a second time to the same 
directory, (by clicking square number 2) I didn’t get a message that the file already 
existed. This needs to be made more clear with a short explanation of it’s purpose. 
 

 
 
 
Conclusion 
 
If Irfanview included a short getting started guide in the About menu, and a short 
explanation or visual diagram of the process, it would appeal to more people and they 
would be more successful using it.  
 
This is a straightforward application that actually packs a lot into the small package. 
There are actually three major utilities – viewing, graphics, and file conversion. There is 
a module that converts images from one format to another, and the program can be set 
up to do a whole batch of files at one time. I will remember it the next time I receive an 
image in a format not listed in my photo manipulation program. 
 
Irfanview proves that you don’t need expensive graphics software to view, convert and 
do minor image manipulation in all the major image formats. 
 


